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Preface: About This Guide
To obtain the current version of the data sheet for Platform Cable USB II, see the Xilinx 
Website at: 

http://www.xilinx.com/support/documentation/data_sheets/ds593.pdf

To obtain the current version of the data sheet for Parallel Cable IV, see the Xilinx Website 
at:

http://www.xilinx.com/support/documentation/data_sheets/ds097.pdf

Conventions
This document uses the following conventions. An example illustrates each convention.

Typographical
The following typographical conventions are used in this document:

Convention Meaning or Use Example

Courier font
Messages, prompts, and 
program files that the system 
displays

speed grade: - 100

Courier bold
Literal commands that you enter 
in a syntactical statement

ngdbuild design_name

Helvetica bold

Commands that you select from 
a menu File > Open

Keyboard shortcuts Ctrl+C

Italic font

Variables in a syntax statement 
for which you must supply 
values

ngdbuild design_name

References to other manuals
See the Command Line Tools User 
Guide for more information.

Emphasis in text
If a wire is drawn so that it 
overlaps the pin of a symbol, the 
two nets are not connected.

Square brackets    [  ]

An optional entry or parameter. 
However, in bus specifications, 
such as bus[7:0], they are 
required.

ngdbuild [option_name] 
design_name

Braces    {  } A list of items from which you 
must choose one or more

lowpwr ={on|off}

Vertical bar    |
Separates items in a list of 
choices lowpwr ={on|off}
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Conventions
Online Document
The following conventions are used in this document:

Vertical ellipsis 
. 
. 
.

Repetitive material that has 
been omitted

IOB #1: Name = QOUT’  
IOB #2: Name = CLKIN’ 
. 
. 
.

Horizontal ellipsis  . . . Repetitive material that has 
been omitted

allow block  block_name loc1 
loc2 ... locn;

Convention Meaning or Use Example

Convention Meaning or Use Example

Blue text
Cross-reference link to a location 
in the current document

See the section “Additional 
Resources” for details.

Refer to “Title Formats” in 
Chapter 1 for details.

Red text
Cross-reference link to a location 
in another document 

See Figure 2-5 in the Virtex-5 
Platform FPGA User Guide.

Blue, underlined text Hyperlink to a website (URL) Go to http://www.xilinx.com 
for the latest speed files.
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Chapter 1

What’s New, Release Notes, and Known 
Issues for 12.1

This chapter discusses important product details and describes how to access the list of 
new features that are included in the products that comprise ISE® Design Suite 12. It also 
describes how to access the Known Issues for ISE Design Suite 12. This chapter comprises 
the following sections:

• “What’s New”

• “Release Notes”

• “Known Issues”

What’s New
This section describes the different ways to access the What’s New documentation.

Microsoft Windows Only
The What’s New documentation is now available only on www.xilinx.com. For links to 
this and other documentation you use the ISE Design Suite InfoCenter. Select Start > 
Programs > Xilinx ISE Design Suite 12.1 > Documentation > InfoCenter.

Online
You can find the What’s New documentation online at:

www.xilinx.com/support/documentation/sw_manuals/xilinx12_1/whatsnew.htm

System Generator for DSP is included in ISE Design Suite 12. For more information on 
System Generator for DSP see Release Notes section of the System Generator for DSP 
Getting Started Guide:

www.xilinx.com/support/documentation/dt_sysgendsp_sysgen12-
1_userguides.htm

PlanAhead software has many new features for 12.1. For more information on What’s New 
in PlanAhead software see the What’s New file:

www.xilinx.com/support/documentation/dt_planahead_planahead12-
1_releasenotes-knownissues.htm
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Chapter 1: What’s New, Release Notes, and Known Issues for 12.1
Release Notes
This section describes important release information.

CORE Generator IP Notes
The first Intellectual Property (IP) Update for the ISE Design Suite 12 CORE Generator™ 
software, IP_12.1.0, is integrated into the initial ISE Design Suite 12 software release and is 
automatically installed with it.

Subsequent ISE 12-compatible updates are cumulative and will be advertised on the Xilinx 
Intellectual Property Center, www.xilinx.com/ipcenter, as they become available. These 
future updates will be downloadable from the Xilinx Download Center, and will also 
usually require installation of specific ISE updates. 

Some IP cores might also require license purchase or installation of a license key to activate 
full access. IP-specific requirements along these lines are documented on the product page 
for each core.

Embedded Tools
Base System Builder now supports the Xilinx SP601 and ML605 development boards. 

ModelSim Xilinx Edition-III
For ModelSim Xilinx Edition-III information see Appendix A, “Simulating Xilinx Designs 
in ModelSim” in the Synthesis and Simulation Design Guide.

To Simulate Xilinx Designs in ModelSim, you must use the Compxlib to compile the 
Xilinx® Simulation Libraries for the target simulator. For more information, see the 
Command Line Tools User Guide.

PlanAhead
Updated Device Support, including the new Spartan-6 low power family. New Virtex-6 
SSN Predictor tool for pin assignment.

Known Issues
Xilinx Answer Record #34466 contains information on Known Issues for ISE Design Suite 
12:

www.xilinx.com/support/answers/34466.htm
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Chapter 2

Operating Systems, Architecture 
Support, and System Requirements

This chapter describes the operating systems and architectures that the ISE® Design Suite 
12 software supports. It also describes system requirements for ISE Design Suite 12. This 
chapter comprises the following sections:

• “Operating Systems”

• “Architectures”

• “System Requirements”

Operating Systems
ISE Design Suite 12 supports three operating systems: Microsoft Windows®, Red Hat® 
Enterprise Linux, and SUSE Linux Enterprise. 

Microsoft Windows
The following table lists Microsoft Windows support.

Table 2-1: Microsoft Windows Support (English and Japanese)

Product
XP Professional Vista Business

32-bit 64-bit 32-bit 64-bit

Design Entry and Implementation Tools (ISE Foundation™ 
software)

Yes Yes Yes Yes

ISE Simulator (ISim) software Yes Yes Yes Yes

ISE WebPACK™ software Yes Yes Yes Yes

ChipScope™ Pro software and ChipScope Pro Serial I/O 
Toolkit Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes Yes Yes No

System Generator for DSP software Yes Yes Yes Yes

ModelSim Xilinx Edition-III (MXE-III) software Yes Yes Yes Yes
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Red Hat Enterprise Linux
The following table lists Red Hat Enterprise Linux support.

SUSE Linux Enterprise
The following table lists SUSE Linux Enterprise 10 support.

Table 2-2: Red Hat Enterprise Linux Support

Product
4 Workstation 5 Desktop

32-bit 64-bit 32-bit 64-bit

Design Entry and Implementation Tools (ISE Foundation 
software) Yes Yes Yes Yes

ISE Simulator (ISim) software Yes Yes Yes Yes

ISE WebPACK software Yes Yes Yes Yes

ChipScope Pro software and ChipScope Pro Serial I/O 
Toolkit

Yes Yes Yes Yes

Embedded Development Kit (EDK) Yes Yes Yes Yes

System Generator for DSP software Yes Yes Yes Yes

ModelSim Xilinx Edition-III (MXE-III) software No No No No

Table 2-3: SUSE Linux Enterprise 10 Support (English and Japanese)

Product 32-bit 64-bit

Design Entry and Implementation Tools (ISE Foundation 
software)

Yes Yes

ISE Simulator (ISim) software Yes Yes

ISE WebPACK software Yes Yes

ChipScope Pro software and ChipScope Pro Serial I/O 
Toolkit

Yes Yes

Embedded Development Kit (EDK) Yes Yes

System Generator for DSP software Yes Yes

ModelSim Xilinx Edition-III (MXE-III) software No No
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Architectures
ISE Design Suite 12 supports the Virtex®, Spartan®, and CPLD architecture families. The 
following table lists the architecture support. 

Table 2-4: Architecture Support

ISE WebPACK software
ISE Design Suite

(Logic Edition, Embedded Edition, DSP 
Edition, System Edition)

Virtex Series Virtex-4 devices:

LX: XC4VLX15, XC4VLX25

SX: XC4VSX25

FX: XC4VFX12

Virtex-5 devices:

LX: XC5VLX30, XC5VLX50

LXT: XC5VLX20T, XC5VLX30T, XC5VLX50T

FXT: XC5VFX30T

Virtex-6 devices:

LXT: XC6VLX75T, XC6VLX75TL

Virtex-4 devices:

LX: All

SX: All

FX: All

Virtex-5 devices:

LX: All

LXT: All

SXT: All

TXT: All

FXT: All

Note: Embedded Development Kit (EDK) 
does not support Virtex-5 TXT devices.

Virtex-6 devices:

LX/T: All including "L" (lower power) 
devices

CXT: All • SXT: All including "L" 
devices

HXT: All 

Spartan Series Spartan-3 devices: XC3S50 - XC3S1500

Spartan-3A devices: All

Spartan-3AN devices: All

Spartan-3A DSP devices: XC3SD1800A

Spartan-3E devices: All

Spartan-3L devices: XC3S1000L, XC3S1500L

XA* Spartan-3 devices: All

XA* Spartan-3E devices: All

XA* Spartan-3A devices: All

XA* Spartan-3A DSP devices: XC3SD1800A

Spartan-6 devices:

LX: XC6SLX4(L)-XC6SLX75(L)

LXT: XC6SLX25T, XC6SLX45T, XC6SLX75T

XA* Spartan-6 devices: All 

*Xilinx Automotive

Spartan-3 devices: All

Spartan-3A devices: All

Spartan-3AN devices: All

Spartan-3A DSP devices: All

Spartan-3E devices: All

Spartan-3L devices: All

XA* Spartan-3 devices: All

XA* Spartan-3E devices: All

XA* Spartan-3A devices: All

XA* Spartan-3A DSP devices: All

Spartan 6 device: LX/T: All including "L" 
(lower power) devices

XA* Spartan-6 devices: All

*Xilinx Automotive
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System Requirements
This section provides information on supported operating systems, Web browser, cable 
installation, and system memory requirements.

ISE Design Suite

Cable Installation Requirements

Platform Cable USB II and Parallel Cable IV are high-performance cables that enable 
Xilinx® design tools to program and configure target hardware.

To install Platform Cable USB II, a system must have at least a USB 1.1 port. For maximum 
performance, Xilinx recommends using Platform Cable USB II with a USB 2.0 port.

To install Parallel Cable IV, a system must have a parallel port connector and support 
parallel port communication.

Cables are officially supported on the 32-bit and 64-bit versions of the following operating 
systems: Windows XP Professional, Windows Vista Business, Red Hat Linux Enterprise, 
and SUSE Linux Enterprise 10. Additional platform specific notes are as follows:

• All Linux: Root privileges are required to install cable drivers on Linux. 

• SUSE Linux Enterprise 10: The fxload software package is required to ensure correct 
Platform Cable USB II operation. The fxload package is not automatically installed on 
SUSE Linux Enterprise 10 distributions, and must be installed by the user or System 
Administrator. 

• Linux LibUSB support: Preliminary support for Platform Cable USB II based upon the 
LibUSB package is now available from the Xilinx website. See Answer Record #25249 
for details. 

For additional information regarding Xilinx cables, refer to the following documents:

• USB Cable Installation Guide (UG344)

• Platform Cable USB II Data Sheet (DS593)

• Parallel Cable IV Data Sheet (DS097)

CoolRunner™ XPLA3 
devices

CoolRunner-II devices

XA* CoolRunner-IIv 
devices

*Xilinx Automotive

All

All 

Note: Embedded Development Kit (EDK) 
does not support CPLDs.

XC9500 Series devices All (Except 9500XV family) All (Except 9500XV family)

Note: Embedded Development Kit (EDK) 
does not support CPLDs.

Table 2-4: Architecture Support

ISE WebPACK software
ISE Design Suite

(Logic Edition, Embedded Edition, DSP 
Edition, System Edition)
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System Memory Recommendations

This section gives the RAM and swap space needed to run ISE Design Suite 12 on your 
system.

While the memory recommendation table, available at the link below, lists the system 
recommendations for typical designs, the unique characteristics of each design affect the 
system resources required. Design complexity and constraints affect whether the design 
can be implemented using more or less memory. Each designer must monitor the system 
resources and adjust the systems resources, if necessary. For more information on memory 
recommendations, see:

http://www.xilinx.com/ise/products/memory.htm

Operating Systems and Available Memory

The Microsoft Windows and Linux® operating system (OS) architectures have limitations 
on the maximum memory available to a Xilinx program. Users targeting the largest 
devices and most complex designs may encounter this limitation. ISE Design Suite 12.1 has 
optimized memory and enabled software support for applications to increase RAM 
memory available to Xilinx software. 

Windows XP Professional 32-bit

Xilinx applications are enabled to take advantage of the memory increase feature on 
Windows 32-bit. You must then modify Windows setting to get access to this larger 
memory. 

The standard Windows OS architecture limits the maximum memory available to a Xilinx 
process to 2 Gigabyte (GB). In Windows XP Professional, Microsoft created an option to 
support the ability of an application to address 3 GB of RAM. Xilinx ISE applications have 
built-in support for this option. To take advantage of this capability, you must also modify 
your Windows XP OS to enable this feature, which requires that you modify your 
boot.ini file by adding a “/3GB” entry to the end of the “startup” line.

Before enabling 3 GB support for Xilinx applications, please read the Microsoft Knowledge 
Base Article #328269 at http://support.microsoft.com/?kbid=328269. If you upgrade your 
computer to Windows XP Service Pack 1 (SP1) and you are using the /3GB switch, 
Windows may not restart without a patch from Microsoft. Please see (Xilinx Answer 17905) 
for more information. 

Additionally, before making this change, please read: 

• Microsoft Bulletin Q17193 http://support.microsoft.com/default.aspx?scid=kb;en-
us;Q171793, which contains information on “Application Use of 4GT RAM Tuning”.

• Microsoft Bulletin Q289022 http://support.microsoft.com/default.aspx?scid=kb;en-
us;q289022, contains instructions for editing your boot.ini file. 

Linux

ISE Design Suite 12 supports both Linux 32-bit and Linux 64-bit. The latter allows greater 
memory allocation. Xilinx has documented Linux kernel modifications that allow a Xilinx 
application to address over 3 GB of memory. 

For 32-bit Red Hat Enterprise Linux systems, the operating system can use the hugemem 
kernel to allocate 4 GB to each process. More information can be found on the Red Hat 
support site: http://www.redhat.com/docs/manuals/enterprise/
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ISE supports the 64-bit version of Red Hat Enterprise Linux, which allows greater memory 
allocation out of the box.

Equipment and Permissions
The following table lists related equipment, permissions, and network connections.

Table 2-5: Equipment and Permissions Requirements 

Note: X Servers/ Remote Desktop Servers, such as Exceed, ReflectionX, and XWin32, are not 
supported.

Network Time Synchronization

When design files are located on a network machine, other than the machine with the 
installed software, the clock settings of both machines must be set the same. These times 
must be synchronized on a regular basis for continued proper functioning of the software.

ChipScope Pro

Cable Installation Requirements

For Linux, cable drivers require root privileges to install. To install Platform Cable USB II 
for USB 2.0 port, you must have Windows XP SP2. The Platform Cable USB II is a high-
performance download cable that attaches to user hardware for use with the ChipScope 
Pro Analyzer tool for device programming, configuring, and debugging. 

System Memory Recommendations

The ChipScope Pro Analyzer software requires 1024 megabytes (MB) of system memory. 
The ChipScope Pro Core Inserter tool has the same requirements as ISE. For more 
information on ISE memory recommendations, see: 
http://www.xilinx.com/ise/products/memory.htm. 

Item Requirement

Directory permissions Write permissions must exist for all directories containing 
design files to be edited. 

Monitor 16-bit color VGA with a minimum recommended resolution of 
1024 by 768 pixels. 

Drive You must have a DVD-ROM for ISE Design Suite (if you have 
received a DVD, rather than downloading from the web), and 
CD-ROM for MXE on your system.

Ports To program devices, you must have an available parallel, or 
USB port appropriate for your Xilinx programming cable. 
Specifications for ports are listed in the documentation for your 
cable.

Note: Installation of the cable driver software requires Windows 
XP Pro SP1 (or later), or Windows Vista Business. If you are not 
using one of these operating systems, the cables may not work 
properly.
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System Generator for DSP System Requirements and Recommendations

Hardware Recommendations

OS and Software Requirements

Table 2-6: System Generator for DSP Hardware Recommendations

Recommendation Notes

2.00 GB of RAM

600 MB of hard disk space Minimum Requirement

Xilinx Hardware Co-Simulation Platform Required for the Hardware Co-Simulation Flow

Table 2-7: System Generator for DSP OS and Software Requirements

Requirement Notes

Windows XP Professional SP2, 32-bit/64-bit 

or 

Windows Vista Business SP1, 32-bit/64-bit

or

Red Hat Linux 4u7, 32-bit & 64-bit

Xilinx ISE Design Suite 12

MathWorks MATLAB Version 2009a or 
2009b

MathWorks Simulink with Fixed-Point 
Toolbox Version 2009a or 2009b

MATLAB must be installed in a directory with 
no spaces (e.g., C:\MATLAB\R2009b)

Fixed-Point Toolbox required for signals 
greater than 53 bits
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Chapter 3

Download and Installation

This chapter describes how to download and install ISE® Design Suite 12 software, as well 
as ModelSim Xilinx® Edition 6.5c. It includes the following sections:

• “Downloading ISE Design Suite 12”

• “Installing ISE Design Suite 12 - Overview for All Platforms”

• “Platform Specific Instructions”

• “Installation Flow”

• “USB FLEXid Dongle Driver Installation”

• “Network Installations”

• “Obtaining 12 Quarterly Releases”

• “Uninstalling ISE Design Suite 12”

• “Installing ModelSim Xilinx Edition 6.5c Software (Windows Only) - Optional”

Downloading ISE Design Suite 12
This section explains how to download the ISE Design Suite 12 software.

To begin, open an internet browser and navigate to 
http://www.xilinx.com/support/download/index.htm

All files in the Xilinx Download Center will be downloaded using the Akamai download 
manager. For the optimum download experience, perform the following:

♦ Allow pop-ups from http://xilinx.entitlenow.com

♦ Set security settings to allow for secure and non-secure items to be displayed on 
the same page

♦ Allow the Akamai download manager to run Java processes

To Download ISE Software:

1. Ensure the Design Tools tab in the web page is selected

2. Under the Version heading, click on the version of the tools you are interested in 
downloading.

3. Click in the link for the installer you wish to download

Note: For 12.x, the installers under the ISE Design Suite heading also contain the standalone 
selections for the Software Development Kit and Lab Tools. Depending on your use case, you 
may not need to download these separate installation programs if you are downloading the ISE 
Design Suite installers.

4. Enter your User ID and Password to log into your Xilinx account.
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Note: If you do not have a Xilinx account, you will need to create one in order to download 
products.

An address verification screen will appear.

5. Once the current address is correct, click Next.

6. The Akamai download manager will launch in your browser to complete the 
download process.

Most files in the Xilinx Download Center are packaged using TAR methods. You will 
need to use software from a third party provider to unpack them. Consult your IT 
department for assistance. Commonly used tools for TAR files are 7-ZIP, GNU built-in 
tools, WinZIP, and WinRar, and these are licensed solely by each respective developer 
and not Xilinx. Xilinx hereby disclaims any warranties, express or implied, including 
warranties of merchantability, fitness for a particular purpose, or noninfringement 
with respect to these suggested software tools.

Installing ISE Design Suite 12 - Overview for All Platforms
This section explains the installation process for all platforms for ISE Design Suite 12. 
Installation for each platform should be preceded by these steps:

1. Ensure that you have appropriate privileges on the system that the software will be 
installed on. Some components, such as programming cable device drivers, require 
administrator-level permissions.

2. Close all programs before you begin installation.

3. Ensure that your system meets the requirements described in Chapter 2, “Operating 
Systems, Architecture Support, and System Requirements.”

4. Check the links found in Chapter 1, “What’s New, Release Notes, and Known Issues 
for 12.1”for any installation issues that pertain to your system or configuration.

5. Ensure if EDK is installed, the installation has to be in a directory structure that does 
not contain spaces.

Note: The ISE Design Suite 12 installers will no longer set global environment variables, such 
as XILINX, on Windows. To find out if this affects the way you execute Xilinx software, see 
“Platform Specific Instructions.” 
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Platform Specific Instructions
This section provides platform-specific details of the ISE Design Suite 12 installation. 

Microsoft Windows 
This section describes how to start the installation for Microsoft Windows operating 
systems.

To Start Installation 

The method of starting the installation depends on how you have obtained the installation 
program. See “Downloading ISE Design Suite 12” for details on your options.

• If you have downloaded an installation file, decompress that file and run the 
xsetup.exe program contained therein.

• If you have ordered and received an ISE Design Suite DVD, load the DVD. If you have 
the auto-run feature of your DVD drive enabled, the setup program should start 
automatically. If it does not, browse to the DVD in Windows Explorer and run the 
xsetup.exe found at the root of the disc.

To Set Environment Variables

At the completion of the installation process, the installation program creates an 
environment variable batch file for you. All appropriate Desktop and Program Group 
shortcuts call this file before launching the target application. A shortcut to a command-
line prompt which sets the environment has been created for you. The shortcut is located at 
Xilinx ISE Design Suite 12.1 > Accessories > ISE Design Suite Command Prompt

To set environment variables in make or script files:

Add <XILINX installation directory>\settings32.bat or settings64.bat 
to your script. 32 or 64 corresponds to the bit-width of the operating system installed on 
the machine

Linux
This section describes how to start the installation and set the environment variables for 
Linux operating systems.

To Start Installation 

The method of starting the installation depends on how you have obtained the installation 
program. See “Downloading ISE Design Suite 12” for details on your options.

• If you have downloaded an installation file, decompress that file and run the xsetup 
program contained therein.

• If you have ordered and received an ISE Design Suite DVD, load the DVD. Click the 
setup file in your file manager, or browse to the root of your DVD drive and type 
./xsetup. 

To Set Environment Variables

At the completion of the installation process, the installation program creates an 
environment variables file for you. 
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1. Go to your XILINX installation directory.

2. Type either source settings32.(c)sh or source settings64.(c)sh, 
whichever is appropriate to your shell.

To set your environment variables manually or from within your setup script, it is 
recommended that you copy the settings from the appropriate file for your operating 
system, as listed above. Xilinx environment variables settings are specific to each operating 
system platform.

Installation Flow
The following section describes important screens that you will encounter during the 
installation process.

Note: For each of the following installation steps, click on the text of any item that has a checkbox 
next to it to obtain more information. Information is displayed in the “Description” area near the bottom 
of the screen.

Accept Software Licenses
After the Welcome screen there are two Accept Software License Agreement Screens you 
will have to click through. To proceed:

1. Click the I accept the terms of this software agreement checkbox.

2. Click Next on each screen.
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Installation Flow
Select Xilinx Products to Install
The following figure shows the screen that allows you to select the Xilinx products you 
wish to install. 

For 12.1, the product selection choices are WebPACK software, various ISE Design Suite 
Editions, and two standalone tools.

Note: The ISE WebPACK product installer will install both ChipScope PRO software and the 
Embedded Development Kit. Although installed, these applications will require a separate license to 
run. 

Select Installation Options
There are several optional installation steps that can be performed during the installation 
process. If selected, these options will install toward the end of the installation process, 
after the main software installation has completed. Several of these options will open 
dialog boxes which will pause the installer until a response is given. 

X-Ref Target - Figure 3-1

Figure 3-1: ISE Design Suite 12 Installation - Select Xilinx Products Screen
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The following figure shows the screen from the Installation Software that enables you to 
select Xilinx installation options. 

Note: Web Talk is always enabled when using WebPACK software. If the ISE WebPACK product is 
selected on the previous screen, the “Enable Web Talk” option will not be selectable. If you install an 
Edition product, the installer will allow you to deselect “Enable Web Talk.” However, if a WebPACK 
license is used to process the design, the “Enable WebTalk” preference will be ignored. Please click 
on the “Enable WebTalk” item, in the installer, and read the description box for full details.

Select Destination Directory
In the Select Destination Directory screen, select the directory in which to install the 
software, and enter a name for the Program Folders list. Please note that the installer will 
add a level of hierarchy underneath the installation path you specify. The name of the 
directory will vary depending upon the type of product you are installing. Any Editors or 
WebPACK software installation will create a directory named \ISE_DS. Lab tool 
standalone installations will create \LabTools and SDK software standalone installations 
will create \SDK. This is done to ensure that Edition and Standalone tools can coexist 
properly on your hard-drive.

X-Ref Target - Figure 3-2

Figure 3-2: ISE Design Suite 12 Installation - Xilinx Modules and Devices
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USB FLEXid Dongle Driver Installation
Installation Options Summary 
The Installation Options Summary screen gives you a summary of the tools, products, and 
options to be installed. If you want to change anything, select the Back button and make 
the desired changes. To begin the installation, click Install.

Towards the end of the installation process, the Xilinx License Configuration Manager will 
open by default. Follow the instructions in the Manager to obtain or locate a license file. 

Note: EDK tools require the Cygwin tools distributed by RedHat. A copy of these tools is distributed 
with EDK installation.

USB FLEXid Dongle Driver Installation
If you have purchased a USB FLEX ID Dongle for use with Windows operating systems, 
you will need to install the appropriate driver prior to creating a FLEXnet license for use 
with it.

1. Install Xilinx ISE Design Suite 12.1 software first. This will contain the installer for the 
USB FLEXid dongle driver.

2. Run FLEXId_Dongle_Driver_Installer.exe found in <Xilinx 
Installation Directory>\12.1\ISE_DS\ISE\bin\nt.

3. On the Select Options screen, ensure that only FLEXid 9 Drivers is checked.

X-Ref Target - Figure 3-3

Figure 3-3: ISE Design Suite 12 Installation - Select Destination Directory
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4. Click Next twice, and the driver will install. 

After installation, a screen will appear asking you if you wish to reboot. You will need to 
reboot to ensure that the dongle operates correctly.

Network Installations
Installing software to a network location provides a way for client machines to access the 
software by pointing to it on the network drive. To run the software on the network, the 
client machines must be set up correctly to ensure that the environment variables, registry, 
and program groups all point to the network. The following sections describe the 
procedure for network setups.

X-Ref Target - Figure 3-4

Figure 3-4: Select Options screen
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UNIX Clients
Each software user must source settings32.(c)sh or settings64.(c)sh 
(whichever is appropriate for your OS) from the $XILINX area where the software is 
installed. This points the Xilinx environment variable, path, and LD_LIBRARY_PATH to 
the installed location.

To run the software applications from a remotely installed location, run an X Windows 
display manager, and include a DISPLAY environment variable. Define DISPLAY as the 
name of your display. DISPLAY is typically unix:0.0. For example, the following syntax 
allows you to run the software on the host named bigben and to display the graphics on 
the local monitor of the machine called mynode:

setenv DISPLAY mynode:0.0

xhost = bigbenPC Clients

Microsoft Windows Clients
1. Install the ISE software tools to a PC network server. Make sure that your users know 

the location of the software tools and have access to the installation directory, and that 
they have Administrator privileges for the following steps.

2. From the local client machine, browse to the following directory: 
network_install_location\common\bin\nt and run the program 
shortcutSetup.bat.

Running this program sets up the Windows settings batch files and Program Group or 
Desktop shortcuts to run the Xilinx tools from the remote location. 

3. From the client machine, launch the ISE tools via the Program Group or Desktop 
shortcuts, or by running the applications on the network drive.

Installing to a Mounted Network Drive
Xilinx software is designed to be installed in a directory under ROOT (typically C: \Xilinx). 
The installer presents this option normally when installing to a local driver, but when 
installing to a mounted network drive, a subdirectory might not be defined and it appears 
to the Installer as if it is installing to a ROOT directory.

To work around this issue, define your target installation directory as "\Xilinx" under the 
network mount point (For example: "N:\Xilinx").

Obtaining 12 Quarterly Releases
Xilinx will release quarterly versions of the ISE Design Suite 12 software throughout the 
year. Each quarterly version will contain device support updates, new features and bug 
fixes. Unlink pervious releases, 12 quarterly releases will only be available in the full 
installation version. There will be no way to update from, for example, 12.1 to 12.3. Instead, 
the 12.3 installer will install a complete 12.3 version into separate directory on the target 
machine. The following sections describe the ways to obtain to software updates through 
XilinxNotify and the Download Center.
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XilinxNotify
The XilinxNotify tool is the preferred method of obtaining software updates. It provides 
the following features: 

• Compares the latest version of Xilinx software updates available on 
http://www.xilinx.com/support with what you have installed, and notifies you if a 
newer version is available. 

Provides a “Download” button that will launch a browser, allowing you to login to the 
Xilinx Download Center. Once you login, the download of your selected product will 
begin. XilinxNotify can be run in any of the following ways:

• Automatic periodic checks at Project Navigator startup time. 

• Select Help > Check for Updates from Project Navigator. 

• Select Start > Programs > Xilinx ISE Design Suite 12.1 > Accessories > Check for 
Updates. 

• Type xilinxnotify in a Linux shell

Note: The Edit > Preferences menu selection in Project Navigator allows you to control the 
frequency of the automatic checks that happen at Project Navigator startup time

XilinxNotify Network Installations

By default, the Automatically check for software updates option at Project Navigator 
startup is enabled on the machine used to install the ISE software to the network location. 
All clients pointing to this network location have this option disabled by default. Client 
users have the option of enabling this option (Edit > Preferences > XilinxNotify from 
Project Navigator) and also running manual checks. 

Note: To perform a software update installation, you must have write permissions for the $XILINX 
installation directory. 

Download Center
Quarterly releases for all platforms are regularly made available on the Download Center 
at: 

http://www.xilinx.com/support/download/index.htm

Uninstalling ISE Design Suite 12

Microsoft Windows
The following sections describe how to uninstall the products that comprise ISE Design 
Suite on Microsoft Windows.

To uninstall any Xilinx product, select the Uninstall item from that product’s Start Menu 
folder. For instance, to uninstall ISE WebPACK software or an ISE Design Suite: Edition, 
select Start > Programs > Xilinx ISE Design Suite 12.1 > Accessories > Uninstall.

Depending on what you have installed, some ancillary applications may also need to be 
uninstalled, such as WinPcap 4.0 (optional component of DSP Tools).

Before uninstalling, be sure you have moved any project files that you want to keep 
outside your Xilinx installation directory structure, or they will be deleted.
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Installing ModelSim Xilinx Edition 6.5c Software (Windows Only) - Optional
Linux 
To uninstall the Xilinx Design Suite product, you need to remove the Xilinx installation 
directory from the shell.

Installing ModelSim Xilinx Edition 6.5c Software (Windows Only) - 
Optional

If you have already purchased ModelSim Xilinx Edition (MXE) 6.5c, you will receive a 
license file after registering the MXE software after installation. For complete product and 
purchasing information for MXE, contact your local Xilinx representative or visit the 
ModelSim Xilinx Edition website:

http://www.xilinx.com/ise/optional_prod/mxe.htm

To install MXE software, perform the following steps:

1. Insert the ModelSim Xilinx Edition CD. 

2. If the CD does not automatically run, select Start > Run > D:\setup.exe.

3. Follow the instructions to complete the installation.

4. Follow the instructions provided to complete a license request. 

A license file will be e-mailed to you.

5. Put the license in a location pointed to by the LM_LICENSE_FILE variable as follows:

set LM_LICENSE_FILE=<path_to_license>\license.dat

You can also cut and paste the contents into your existing license.dat file.

Note: MXE is not a supported simulator for Xilinx Platform Studio.
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Chapter 3: Download and Installation
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Chapter 4

Obtaining and Managing a License

The Xilinx® Product Licensing Site is an online service for licensing, and administering 
evaluation, and full copies of Xilinx software and IP products. This chapter describes the 
FLEXnet license generation functionality of the Product Licensing Site. It includes the 
following sections:

• “Accessing the Product Licensing Site”

• “Product Licensing Accounts”

• “User Types and Actions”

• “Creating a License Key File”

• “Managing License Key Files”

• “Managing User Access to Product Licensing Account”

• “Installing Your License Key File”

Accessing the Product Licensing Site
The Product Licensing Site is accessible in various ways depending upon the type of 
license being generated.

• If you purchased products, follow the link included in your order confirmation email. 
It will provide direct access to an account containing your product entitlements.

• If you want to evaluate ISE® Design Suite 12 products, go to 
www.xilinx.com/ise_eval.

• If you want to evaluate IP products, go to www.xilinx.com/ipcenter and follow the 
“Evaluate” link on the IP product page of interest.

• You may also access the Product Licensing Site directly by going to 
www.xilinx.com/getproduct. You will need to register or enter your registration 
information first.
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Chapter 4: Obtaining and Managing a License
You must first sign in. If you already have a Xilinx user account, enter your user ID and 
password, and then validate that your contact information is current. If you do not have an 
account, click the Create Account button.

Product Licensing Accounts
When you purchase a software or IP product from Xilinx, you are purchasing a license to 
use and receive updates for that product for one year. The license to use Xilinx software 
and IP products is managed through the use of product entitlements. A product 
entitlement is the determination of:

• Which product was purchased

• The number of seats purchased

• The license type (floating or node-locked)

• The product subscription period (product updates are provided throughout the year)

In addition to managing the product entitlements for your purchased software tools and 
IP, you can also access product entitlements for “No Charge” or “Evaluation” products. 
Full and No Charge licenses have a subscription period of one year. Software tools 
evaluations are for 30 days, and IP evaluations are for 120 days.

Activating a product entitlement results in one or more license keys being generated by the 
website. When installed, the license keys enable the use of the software and IP that was 
purchased or is being evaluated. Your product entitlements and resulting license key files 
are managed in a product licensing account on the Xilinx website.

Product licensing accounts are specific to the individual listed on the Xilinx Software 
Purchase Order, which is either the end-user or administrator of the software. All 
purchases made can be managed in the same product licensing account if a single 
administrator is named, or a company site can have multiple accounts managed by 
different administrators. The latter is helpful if a site has multiple design teams working on 
differing projects with different budget pools.

Note: A license key can be generated for a product entitlement that has expired; however, it will only 
enable product releases up to the subscription end date. Applying a product update that was made 
available after the subscription end date of your license will result in an error.

X-Ref Target - Figure 4-1

Figure 4-1: Xilinx Sign In Page
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User Types and Actions
LogiCORE IP License Generation In ISE Design Suite 12
Beginning in ISE Design Suite 12, LogiCORE™ IP licenses are no longer generated through 
lounges on the Xilinx website. Instead, the entitlement process for LogiCORE IP has been 
automated and will use the same electronic entitlement process used for other software. 
When a purchase order for LogiCORE IP is entered into the Xilinx system, it will be 
processed in less than 2 hours, following which you can generate LogiCORE IP licenses on 
the Product Licensing Site, as described in this section.

Any IP and software entitlements you have purchased will appear in your list of entitled 
products when you log into the Product Licensing Site. Licenses for Evaluation and No 
Charge IP will also be available on the site in a separate area. Licenses for all your software 
and IP can now be generated in one pass and are emailed to you in a single license file. In 
addition, IP core FLEXnet licenses now feature more licensing options, such as single or 
Triple-Redundant Floating Server support, and more host options for node-locked license 
keys: Ethernet MAC address, Hard-Drive Serial Number or USB Dongle ID.

User Types and Actions
There are three user types for the Product Licensing Site: customer account administrator, 
end user, and evaluation user. 

Customer Account Administrator
An example of a typical customer account administrator is a CAD tools manager. Every 
product licensing account must have at least one customer account administrator. A 
customer account administrator can manage more than one product licensing account. 

The responsibilities as the customer account administrator include:

• Generating node-locked or floating licenses for Xilinx software and IP products.

• Adding and removing users from the product licensing account (as desired).

• Assigning administrative privileges to other users (as desired).

• Ordering product DVDs (if applicable).

The original customer account administrator is the “Ship To” contact that is identified 
during the product ordering process. That person will receive an email with instructions 
on how to download and license each of the products that were purchased. It is important 
that the customer account administrator follow the link in the email, as it will ensure that 
he can obtain access to the purchased products.

End User
Adding end users to a product licensing account allows an engineer or design team 
member the flexibility to manage and generate license keys on their own. The end user 
may generate license keys for node-locked products entitlements within the account. An 
end user is also allowed to generate license keys for evaluation software and evaluation of 
no charge IP products. Some restrictions are placed on the role of end user.

• An end user is not able to generate floating license keys. Only customer account 
administrators can generate server based (floating) license keys. Product entitlements 
for floating licenses are not viewable by end users in an account.

• An end user is not able to view the license keys generated by other users.
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Chapter 4: Obtaining and Managing a License
• An end user is not able to add or remove other users to or from the product licensing 
account.

Evaluation User
An evaluation user is someone who would like to test-drive ISE Design Suite 12 products. 
Evaluation users can:

• Generate a 30-day free evaluation license key for ISE Design Suite 12: System Edition

• Generate license keys for evaluation and no charge IP products

• Request an ISE Design Suite 12 DVD. Evaluation users must pay for the shipping of 
DVDs.

Note: A customer who is already licensed for a full version of an ISE Design Suite product edition 
can test-drive other ISE Design Suite product editions or IP. These product entitlements are made 
available in the same product licensing account.

All user types can download products electronically and request an ISE Design Suite 12 
DVD.
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Creating a License Key File
Creating a License Key File
The Create License tab on the Product Licensing Site is the starting point for license key file 
generation. The software tool and IP product entitlements you have purchased or wish to 
evaluate are presented in the product entitlement table. 

Selecting Products
Begin the license generation process for products you have purchased or wish to evaluate 
by performing the following actions:

1. Select the product licensing account you wish to administer.

2. From the Account drop-down list, select your desired account.

Note: This selection will not be available if you are only entitled to evaluation or free products.

3. Make your product selections from the product entitlement table.

The type of product entitlements available are Full (purchased), No Charge, or Evaluation. 
Full and No Charge licenses have a subscription period of 1 year. Software tools evaluation 
is for 30 days, and IP evaluations are for 120 days.

Floating and node-locked licenses cannot be combined in the same license key file, and the 
interface is designed to prevent this.

X-Ref Target - Figure 4-2

Figure 4-2: Create New License
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